Watch Geoff Live: Digital Images
By Geoff Rasmussen

In the past couple of months I've taken another 200 pictures or so with my digital camera. It’s time to
import them to my computer, get them organized and searchable, and publish them to the cloud so the
rest of the family can see what we’ve been up to. With the hope that others might benefit by watching
the process, I've waited until this webinar to do it all.

Because the “Watch Geoff Live” webinars are live and unscripted, it prevents me from preparing a
complete syllabus with step-by-step instructions for everything that is covered. | simply do not know all
of the angles we will cover during the presentation. However, since the process of importing, organizing,
and publishing my camera’s digital images is mostly the same every time, | can provide you with some

guidance.

The few pages that follow are excerpts from my Digital Imaging Essentials book...They cover:
e the two steps to transferring a photograph from your digital camera to your computer (pages
49-52)
e introduction to organizing your digital files on your hard drive (pages 75-84)

These syllabus pages do not cover the keyword tags, facial recognition, and a few other things we’ll go
over in the webinar. But here’s the link where you can have access to everything! ©


http://legacy.familytreewebinars.com/digital-imaging-essentials-p163.php

Chapter 5 ¢ How to Import from your Scanner or Camera

Step #3 — Copy digital images to your computer.

The Flip-Pal mobile scanner stores scans on the SD memory card the same way your digital
camera does. When you are ready to use the digital images, transfer them to your computer

using a card reader.

e To remove the SD card from the scanner, push it in gently. It will then spring out
slightly, allowing you to slide it out. Note: it is recommended that you power off the
scanner before removing the SD card.

Two Steps to Transferring a Photograph from your Digital Camera to Your
Computer

1. Connect your camera or card reader to your computer.

2. Import pictures to your hard drive.
Step #1 — Connect your camera or card reader to your computer

Once you have snapped a bunch of pictures with your digital camera, to move them from
y pp p y gt >

your camera to your computer is a matter of connecting the two together. Your camera
probably came with a USB cable. Connect one end into the camera and the other into an

open USB port on your computer and turn your camera on.
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The problem with this method is that I often forget to turn my camera back off when I am
done importing which completely drains the battery. The solution is to use a USB card
reader like the one shown below. The reader plugs into the USB port of your computer,
and then the SD card plugs into it.
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Or, computers, especially laptops, now come with the card reader built in so you may not
need a cable or an external card reader.

Step #2 — Import pictures to your hard drive

Once connected, your computer may display the Windows Auto Play dialog. If you are
using something other than Photoshop Elements, select the “Copy pictures to a folder on
my computer” option and follow the prompts. You will need to manually browse to the
location where you want to save the pictures. If you are using Photoshop Elements, click
the Organize and Edit button.
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If the Windows Auto Play dialog does not appear, open Photoshop Elements and go to
File > Get Photos and Videos > From Camera or Card Reader.

Get Photos from:
|E:\<canON_DC> x|
2 Files Selected - 343.6KB
—Import Settings
Location: Ci\Users\Geoff's Toshiba\Pictures\[1 subfolder] Browse... I
Create Subfolder(s): IShot Date {yyyy mm dd) j
Rename Files: IShnt Date (yyyy mm dd) :I
| +|1
Example: 2012 09 24_0001.IFG
[ Preserve Current Filename in XMP
W Open Organizer when Finished
Y IAﬂ:er Copying, Verify and Delete Criginals _ﬂ
™ {Automatic Download:

Advanced Dialog | Get Media cancel |

On the Photo Downloader dialog, your camera should be selected in the “Get Photos
from:” section. Next, make sure that the “Location” is set to where you want to save the
pictures. Next, within that folder, because the “Create Subfolder” choice shows the syntax
of yyyy mm dd, it will automatically create folders based on the date that the pictures were
taken. Finally, I prefer that the pictures are renamed to their shot date by choosing that
option in the “Rename Files” section. Notice the example of “2012 09 24_0001.JPG” —
this is how the file name will be saved when imported.
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The last dialog you will see will be:

Elements Crganizer

wou just imported. To

Con't Show Again

Your pictures have now been imported and are ready for your keyword tags (which you
will learn about in the Organization chapter).
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Getting Organized

When I worked for a genealogy research company in Salt Lake City we had a goal to be

able to file and retrieve any document in under a minute. Time was money. I have carried
this goal into my personal digital filing system. If your digital collections number into the
hundreds or even thousands, and you can locate any picture in under a minute, you know

that you have a good digital filing system.

The organizational system I will describe below enables you to locate your digital pictures
chronologically, geographically, by subject, by family, or even by face using facial
recognition technology. Using these techniques you should be able to quickly locate what

you are looking for.

After creating a digital image, either with your scanner or your digital camera, you have the
choice of where to store that image. It can be stored on your hard drive, on a USB drive, a
DVD drive, your camera’s SD card, in a Dropbox folder, or even on a web server (the
cloud). My recommendation is to use a combination, but always start in the same place —
your hard drive. Keep in mind that any of these media can fail at any time, so make sure

that you have a good backup strategy in place.
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I store my digital images in two different locations on my hard drive.
The My Pictures folder — for my personal photographs and scanned images
C:\Genealogy Photos Pictures — for my digital genealogy documents

My Personal Photographs and Scanned Images

The My Pictures folder is where Windows stores your personal pictures by default. When
importing pictures from your digital camera, almost always it directs you to save the
pictures in the My Pictures folder. Within this folder it is a good idea to create subfolders
to help you more easily manage your pictures. If all 17,861 of my personal digital images

were in the same folder it would be more difficult to locate what I am searching for. Here’s
a snapshot of what the folder system looks like. Notice that each folder begins with the
four digit year, followed by a hyphen, followed by the two digit month. With this syntax,
the folders can easily be sorted by year.

? e {EI » Libraries » Pictures » - ' Search Pictures

Organize » Share with » Slide show Burn MNew folder &~ O @
45 Favorites —  Pictures library Amange by: Folder =
B Desktop Includes: 2 locations
mF WM B R N
i Recent Places ! |
1976-03 1976-05 1976-07 1976-08 1976-10 1976-11 1976-12
. Dropbox
Magic Briefcase A _ i - m F fl
= _l: - | - |
4 Libraries 1977 1977-01 1977-03 1977-05 1977-06 1977-07 1977-08 [l
b ij Documents By I | ] :
[ El] Dropbox ﬁ h 5 i i @ "
> @ Millennia 1977-09 1977-10 1977-12 1978 1978-01 1978-02 1978-03 |
b J‘P Music — ¢ ,
I* =] Pictures % g m E h ﬂ
> I Videos 1978-04 1978-07 1978-08 1978-09 1978-10 1978-11 1978-12

b :'gﬂ Webinars

+ & Harmgen ¥ R B R X & &

- 1979 1979-02 1979-03 1979-04 1979-05 1979-06 1979-07

= 1,010 items State: 22 Shared
L
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Inside the 1978-09 folder it looks like this:

K5 J=|  » Libraries » Pictures » 1978-09 R

Organize * Share with + Slide show Burn Mew folder BEl o« D @

Search 1978-09

it Favorites Pictures library
B Desktop 1978-09
4. Downloads

Arrange by:  Folder =

= —
=il Recent Places

.. Dropbox r :
1978-09-00 1978-09-02 1978-09-00 1978-09-00

B Madic Brdiease 02.4if -000Ltif 03.4if 04.4iF 1

m

4 Libraries I
@ Documents
gﬂ Dropbox I
il Millennia
JT Music ]
| Pictures
B videos

gﬂ Webinars

!@ Homegroup

l 4 ftems State: 28 Shared

The file name of each picture in this folder uses this syntax: yyyy-mm-dd-#### followed
by the picture’s file extension (.tif, .jpg, etc.). Because of how I have named these files, it is
not likely that I will ever have a duplicate of the file name on my hard drive.

I manually created these folders and files based on the approximate dates of the pictures.
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Now that I use a digital camera, when the pictures are imported to my hard drive, the

software creates the folder and file syntax (which I can manipulate if desired). Here’s what

the folders look like:

[l=| » Libraries » Pictures » - :. Search Pictures

& Homegroup

%

1978-09

- & B B B B A

State: 24 Shared

File folder Date modified: 9/14,/2012 8:49 AM

Shared with: Everyone

And here’s what the files inside one of these folders look like:

Organize » Share with » Slide show Burn Mew folder BE.o- [ @
1t Favorites — Pictures library Anangeby: Folder ~
B Desktop 20071218
4 Downloads
| Dropbox 200712 2007 12 200712 200712 200712 200712 200712
- 21 0154.0P 21 0155JP 210155 edi 21 0156JP 210156 edi 21 015?JP 21_0158.)P
Magic Brief . o 010 s
SERRNES 2 6 G ted-1.0PG ted-1JPG G
= 5 ] 1
"R .- NN
5 Documents 200712 200712 200712 200712 200712 200712 200712 |
15} Dropbox 21 0158 edi  21.0159JP 210159 edi 21 0160.JP 21 0161JP 21 0161 edi 21 0162JP ||
= ted-1.JPG G ted-1.1PG G G ted-1.JPG G i
il Millennia |
s L '
|E&] Pictures 200712
- 21 0163.JP
S Videos G |
@l Webinars
% Homegroup

l 15 items

State: B Shared

Organize » w3 Open Share with = Slide show E-mail Burn New folder o= [ @
7't Favorites — Pictures I|brary Arangeby: Folder ~
B Desktop Includes: 2 locations
4 Downloads -
i Recent Places m L
| Dropbox
Magic Briefcase | 20081030 20081031 20081101 20081108 2008 200811 14 20081122
; |
4 Libraries I
[; 7 L
@ Documents 200811 28 200812 06 20081209 20081211 20081219 200812 24 200812 25 il
gﬂ Dropbox ﬂ
)| Millennia m H ' h o |
JP Music — LA
200812 26 200812 27 200812 29 20081230 2009 01 06 200901 07 2009 01 08
|E&] Pictures
g a m A @
g[] Webinars |
2009 01 09 20090110 20090111 20090112 20090116 20090117 20090118

=

|
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The files use the syntax of yyyy mm dd_#### followed by the picture’s file extension. I
think we take way more pictures today than we did before digital cameras.

To summarize — for my personal photographs and scanned images, I use the My Pictures
folder with subfolders.

My Digital Genealogy Documents

One of my favorite repositories of genealogical information is the Family History Library
in Salt Lake City. With their more than 2.4 million rolls of microfilm, over 1 million
microfiche, and 3 billion pages of family history records, we are sure to find something
about our ancestors. Combing through all these records without a catalog would make it
very difficult to locate your records. Their catalog, now known as the FamilySearch
Catalog, lets you search for record collections in a number of ways, but more often than
not we search for records in one of two ways.

First we locate records geographically. To see what their collections hold for Minneapolis,
Minnesota, we would use the “Place-names” category and type in Minneapolis. The catalog
reformats the location to display its geographic hierarchy in reverse order, showing us that
Minneapolis is a sub-location of Hennepin (the county in this case), which is a sub-location
of Minnesota (its state). Clicking on the Search button would present us with the register of
their holdings for Minneapolis.

Records Trees Catalog Books

FamilySearch Catalog is in [3£3 . You can still visit the previous version.

Search For

Place-names E Minnesota, Hennepin, Minneapolis

Second we locate records by surname. To see what their book collections hold for the
surname of Brown we would use the “Last Names” category and type in Brown. Clicking on
the Search button would present us with the register of their holdings for this surname.
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Records Trees Catalog Books

FamilySearch Catalog is in [35) . You can still visit the previous version.

Search For
Last Names [=] |Brown|

What does this have to do with digital images you say? I have set up my digital genealogy
filing system to match the same organizational structure. Within my C:\Genealogy Photos

Pictures folder, I have two sub-folders: Locations and Surnames.

)

3' \. » Computer » Local Disk (C:) » Genealogy Photos Pictures »

Organize = Include in library = Share with = Slide show Burn Mew folder =~ [ @

“El Recent Places 4 = .

.. Dropbox

. Magic Briefcase |

4 Libraries f L‘ i
@ — Locations Surnames
ﬁa Dropbox
5 Millennia
J’ Music
|&=| Pictures
B videos
|g|] Webinars

m

#& Homegroup

1M Computer
&, Local Disk (C:)
cw Mew Volume (D)

, 2 items

w —

Within the Locations folder, I have created sub-folders for the countries for which I have

digital images.
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Organize »

Include in library =

Share with - Burn

K9\ )% <« LocalDisk(C:) » Genealogy Photos Pictures b Locations » = Search Locations

MNew folder

“El Recent Places
. Dropbox
. Magic Briefcase

- Libraries
@ Documents
ﬁﬁ Dropbox
i) Millennia
Jl Music
[E] Pictures
B Videos

Eﬂ Webinars
*& Homegroup

e Computer
&, Local Disk (C)
= New Volume (D)

, 4 items

F

m

o

4

o~
MName
|, Canada
.. Denmark
. England
. UsSA

Date modified

2/9/2011 6:07 PM
2/9/2011 6:07 PM
2/9/2011 6:07 PM
6/17/2012 10:07 AM

Type Size

File folder
File folder
File folder
File folder

e e moae o

1

Organize = Include in library = Share with = Burn MNew folder =+ [ @
™ >
1=l Recent Places 4 MName Date modified Type Size
.. Dropbox . ;
o \u Arizona 2/9/2011 &:07 PM File folder
. Magic Briefcase _ )
T | Arkansas 2/9/2011 6:07 PM File folder
o | California 2/9/2011 6:07 PM File folder
= Libraries s ) o |
, . Connecticut 2/9/2011 8:07 PM File folder =
@ Docurments ) ) |
s | Florida 5/3/2011 213 PM File folder L]
gﬂ Dropbox : '
_-: ) General U.S 2/9/2011 6:07 PM File folder I
=1 Millennia )
o 1 Idaho 2/9/2011 6:07 PM File folder |
J' Music = . . L
i L Hllinois 2/9/2011 6:07 PM File folder [
[ Pictures :
) 1 Iowa 2/9/2011 6:07 PM File folder l
E Videos )
. . Kansas 7/19/201210:31 AM  File folder ||
@ﬂ Webinars : ; i
L. Maine 2/9/2011 6:07 PM File folder 1
. Massachusetts 2/9/2011 6:07 PM File folder
#d Homegroup . .
- |, Minnesota 8/23/2012 3:10 PM File folder
. Missouri 2/9/2011 6:07 PM File folder I
1M Computer ) )
; 1. Montana 6/13/2012 9:39 AM File folder
&, Local Disk (C) _
| Mebraska 4/23/2012 3:57 PM File folder -
—a New Volume (D) ) i | v

, 30 items
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All the way down to the city/town/township level.

Organize = Include in library = Share with = Slide show Burn Mew folder == [ @l
5l Recent Places - ot
. Dropbox =
| Magic Briefcase i == ‘
2! ; -- - — = -y I
4 Libraries S =y o b | 4
@ Docuimants 1865 City 1865 City 1880 Census - Brown, Asa C - Brown, Asa C. - |
Directory - Page Directory - Page  William C Brown 1860 census.jpg death record in
El] Dropbox 15.pg 17.pg family,jpg family bible,jpg
=) Millennia - |
&1 Music 5 — |
e Fiw =TT |
|| Pictures i I
E Videos J : ]
R 4 15 |
@l Webinars = : L2 A | |
Erown, Lorenzo - Brown, Lorenzo - Brown, Lorenzo Brown, Lorenzo Brown, Loring -
1885 census.jpg 1895 census.jpg D. - Death D. - Obituary.jpg 1920 census.jpg
g Homegroup B Certificate.jpg
1M Computer
&, Local Disk (C) |
= New Volume (D:) o | T -
l 13 items |
—

In most cases, if I were to try to locate these same documents in the FamilySearch catalog,
they would be cataloged using the same directory structure as my digital filing system.

Within my Surnames folder, I store photographs, pdfs of books relating to a surname,

research reports I have written about that surname and more. To protect the privacy of my

living relatives I have not included an image here, but within this folder, you can create as

many sub-folders as you want. Again, in most cases, if I were to try to locate these same

types of documents in the FamilySearch catalog, they would be catalogued using the same

directory structure as my digital filing system.
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Another Golden Rule

Once your digital files are stored on your hard drive:

e Do not move them to another location.

e Do not rename them.

At this point, you will probably link many of these digital images to your genealogy
management software (like LLegacy Family Tree! or others...). When you do, that software
does not make another copy of the image to store it into its database. Doing so would not
only duplicate the images, but because of the increased file size to its database, the database
would become more and more unmanageable and more difficult to share with others. The
genealogy software stores the /nk to the picture. It is able to create a small thumbnail of
the picture to display to you, but keep in mind that it only stores the name and location of
the digital file. If you change the file’s name or move it to another folder or drive, the next
time you open your genealogy software to view that picture, you will get some kind of
“broken link” or “question mark” graphic. Good genealogy software provides the ability to
relocate the picture, which works well if you have only moved the picture, but does not
work well if you have either deleted or renamed the picture. It simply does not know what
happened to it.
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The same is true with your photo management software. For example, I somehow lost one
of my early digital images. I either renamed it, removed it, but most likely it just flew away,
because I would never claim fault for it....Let’s just pretend that it was my fault.
Photoshop Elements no longer knows where the picture is so it displays the following

graphic instead.

Photoshop Elements does have a handy tool to try to reconnect these types of pictures (go
to File > Reconnect > Missing File) but it is easier in the long run to follow these two
golden rules. In my experience, Picasa, on the other hand, is able to locate pictures that
have been renamed. However, if you move them to another location, make sure that Picasa
is configured to also watch the other location for new files (go to Tools > Folder Manager
for these settings).

Photo Organizing Software

Now that you have a little guidance with your folder and file system, are you able to use it
alone to quickly locate anything in under a minute? Probably not. But since all of your
photographs have now been digitized and saved on your hard drive, you have made a giant
step in this direction. This is where a good photo management program comes in. Both
Photoshop Elements and Picasa excel in organizing your digital media. Lifestory’s Heritage
Collector Suite software also deserves a look as it is organizational software developed by
genealogists for genealogists, although it lacks photo editing tools.

Photoshop Elements

The first time you run Photoshop Elements it will ask you if you want it to scan your
computer for any media. Click Yes and it will begin to happily crawl your hard drives for
any media files. You are also given the choice as to which folders and drives to scan. Since
I use the photo organizer software to manage only my personal media, I do not need it to
scan my c¢:\Genealogy Photos Pictures folder. After making your selections, Elements will
begin scanning. When it is complete, your Catalog will contain thumbnails of your media.
The catalog contains information about each photo and media file, but it does not contain
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